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Introduction
CoPre 2 is a CHCNAV self-designed LiDAR raw data pre-processing software. It supports
multiple useful functions: POS process by self-designed algorithm; One-button processing,
simple and efficient; Point cloud process, picture collate, depth map, data colorize all
available; Adjust & refine functions which can improve post-processing accuracy; Mass point
cloud data viewing etc.
Main functions of CoPre 2 software:
POS processing: Supports POS file processing. Both points select, box select, polygon select,

and time select are available.
Auto-processing: One-button process point cloud data, picture collation, point cloud

colorize, depth map and results output.
Adjust: Solve the layering problem of multiple point clouds, improve data accuracy.
Refine: Based on control point characteristics, supports elevation, horizontal, 3D refines,

and time/distance refine functions, improve data accuracy.
Result export: Output adjusted/ refined result data, include point cloud, pictures, colorized

point cloud and depth map.
Point cloud view: Support mass of data viewing, rendering, slice, and control point select

option.

1 Installation
This chapter describes the requirements on the operating system, hardware devices,
installation and uninstallation of CoPre software, and precautions.

1.1 PC Hardware Requirement
Operating system Microsoft Windows7 (64bit)

Microsoft Windows10 (64bit)

CPU Minimum: 2+ GHz
Recommend: 3.5+ GHz

Memory Minimum: 16GB
Recommend: 64GB

GPU Only NVIDIA is supported, GTX1050ti and above
Graphics card driver after 2021

Display resolution 1920*1080 above

.NET environment .NET Framework 4.0
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1.2 Software Installation
Notes
Turn off 3rd party antivirus software in case the install process being interrupted. And the
install path need complete English letters.
Open software package then confirm “I agree” on license terms and continue installation:

Waiting software install completely:
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When software installed successfully, click finish to close current interface.

1.3 Software Uninstall
First way, click “Start” to open windows start menu. Find CoPre 2 folder then click “Uninstall
CoPre2” and click yes to start uninstall.

Second way, go to “Settings – Apps”, and find CoPre 2 then right click to uninstall.
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2 Data Structure

This chapter introduces the engineering structure and data storage method used in CoPre
software solution

2.1 Project Structure
A complete CoPre 2 project structure contains 4 folders: GPS, IMG, SCAN and TRACE.

2.1.1 GPS

Base: Need copy receiver static data inside. Support HCN and RINEX 3.02 formats.
Ctrl: Storage control point file. Empty by default.
Post: Storage POST file. Empty by default, and after POS process finished, user can

find .post file inside.
Rover: Storage LiDAR GNSS data and IMU data.
Rtk: Storage RTK data under none-base mode. Empty by default.
Sync: Storage camera trigger data. Empty by default.
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2.1.2 IMG

This folder stores AA450 picture data. And CP is the configuration files of this set of camera
data.

2.1.3 SCAN

This folder stores raw laser data of LiDAR. And EP is the configuration files of this set of laser
data, which contains the lever arm information of antenna. Different drone will use
different .EP file as the antenna location is different.

2.1.4 TRACE

Storage test log data and normally is empty.
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2.2 Task Structure
A complete CoPre 2 task contains Reconstruction folder, Results folder, SolveProjects folder,
coc file, cpr file, crd file and db file.
Reconstruction file is the temporary data folder generated during reconstruction.
Results file is the final output result folder, including point cloud, orthophoto, model and

other result files.
.coc file contains the project coordinate system information.
.cpr file is the task project file.
.db file contains the GCP information of ground control points.
.crd file is the coordinate system file that produces the result.

2.2.1 Reconstruction Folder

Reconstruction folder is the temporary data folder, contains AT_Temp, DOM_Temp and
Model_Temp.

2.2.2 Results Folder

Results folder contains final output information after generate result in CoPre 2. Depends on
different processing modes, it might have 4 type folders: auto-solve result, adjust result,
refine adjust and adjust & refine together result.
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AUTOSOLVE: For a complete auto-solve workflow, it should contain camera and scanner
folders with auto processed result files (picture, depth map, point cloud data).

ADJUST: For a complete adjust workflow, it should contain camera and scanner folders with
adjusted result files (picture, depth map, point cloud data).

REFINE: For a complete refine workflow, it should contain camera and scanner folders with
refined result files (picture, depth map, point cloud data).

ADJUST_REFINE: For a complete adjust & refine workflow, it should contain camera and
scanner folders with adjust & refined result files (picture, depth map, point cloud data).

2.2.3 SolveProjects Folder

SolvedProjects folder contains intermediate output information after preprocess in CoPre 2.
Depends on different processing modes, it might have 4 type folders: GPS, REFINE, ADJUST,
SOLVED.
GPS: For a complete preprocess workflow, it should contain base and rover folder with

relative GNSS & IMU files.
SOLVED: For a complete preprocess workflow, it should contain preprocess files

with .codata format.
ADJUST: For an adjust preprocess workflow, it should contain new adjust POST file

with .codata format.
REFINE: For a refine preprocess workflow, it should contain new refine POST file

with .codata format.
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3 Main Interface

This part includes task management, project management and window, as shown in the
following figure

3.1 Task & Project

Task & Project mainly include Task Wizard, Create Task, Open Task, History Task, Close Task,
Coordinate and related Settings of the calculation project

3.1.1 Task Wizard

Description
Create a new CoPre 2 task wizard to guide client process data.
Steps
Click “Main – Task – Wizard” to start data import.

On step 1, configure the task name, project data path, output data path, units and task
description (option). Then, click next.
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On step 2, Coordinate system setting, the user clicks the button on the right side of the
coordinate system to set the coordinate system parameters.

On step 3, select the data source and result type, the data source can choose laser and
image, and the output can choose laser point cloud, orthophoto image and 3D model.
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On step 4, configure the base settings to process POST file. Click “Next” to start process,
and the POST file will be loaded automatically when finish.

On step 5, select target trajectories to process point cloud & picture data. Click “Next” to
start process.
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On step 6, set the parameters related to the results, and then click “Finished”.
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CoPre 2 will load result automatically when finished. User can view data on software
interface.

3.1.2 Create Task

Description
Create a CoPre 2 task. Each task can contain multiple projects.
Steps
Open “Main – Task – Create” to start data import.

Notes
Both project data path and output data path not support non-English letters and space.

Save the data under English path.
There are two types of time base: GPS-1970 means time is start from 00:00:00 of January

1st 1970; GPS-1980 means time is start from 00:00:00 of January 6th 1980.
Configure task name, project data path, output data path, units and task description

(option). Finally, click “Create”.
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The CS settings window will display on interface, click “more” to set the CS settings.

3.1.3 Open Task

Description
User can click “Main – Task – Open” or double click .cpr file to import an exist task.
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Steps
Click “Main – Task – Open” on toolbox and choose .cpr file to open an exist task
User can also double click .cpr file in folder to open task.

3.1.4 History Task

Description
List all history tasks and switch between different tasks.

Steps
Click “Main – Task – Recent toolbox.

3.1.5 Close Task

Description
User can close already opened task.
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Steps
Select target task node.
Click “Main – Task – Close” or right click selected node to close.

3.1.6 Coordinate

Description
Set the coordinate system for the current task.

Steps
Click “Main – Task – coordinate” on toolbox.

Ellipsoid: Include Name, a, 1/f and positive direction.
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Projection: Include common Gaussian, UTM, Mercator projection etc.
Datum Transform: Include 3-parameters, 7-parameters, grid etc.
Plane calibration: Include 4-parameters and best practice parameters.
Elevation fitting: Include fixed difference, surface fitting, curve surface fitting and best

practice. Fixed difference requires at least one starting point. Surface fitting refers to
the elevation anomaly corresponding to multiple leveling points to generate an optimal
surface. When the surface is parallel to the horizontal surface, the surface fitting is
equivalent to fixed difference correction. This fitting method requires at least three
starting points. Curve surface fitting refers to the elevation anomaly corresponding to
multiple leveling points to generate an optimal paraboloid. The curve surface fitting has
a relatively high requirement on the starting data. If the fitting result is too bad, it may
cause the divergence of elevation correction number in the work area. This fitting
method requires at least six starting points. Best practice can input the corresponding
parameters according to the real situation.

Geoid model: Users can choose a geoid file and interpolation method according to the real
situation. The software supports several kinds of geoid files, including none, CGD
file, GGF file, GRD file, BYN file, GSF file, BIN file, BYN file, GDF file, JASC file and OSGB
file.

Plane grid: Supports plane horizontal east grid and plane horizontal north grid (CGD, GRD,
PXY, OSGB, DAT formats).

Note: The central longitude of the current coordinate system must be within a 24° range
of the actual data's central longitude when setting projection parameters.

3.1.7 Import Project

Description
Import raw project folder. There are two ways to import task, both support multiple tasks
import at same time.

Steps
After creating a new task, click “Main – Project – Import” or right click RawWorkspace and

choose import project to load. First way is import project from LiDAR device directly;
Second way is import project from PC local disk.
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3.1.8 Import External Data

Description
User can import other camera data.
Steps
Right click Task and choose to import external data to load.

Choose image folder to load.
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Click Import to import camera POS.

After import, use “Separator” to divide contents. Make sure the column number is
corresponded to their contents (Name, E, N, H etc).
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Click “OK” to import. After import successfully, choose import camera parameter to load.

Click “OK” to import.
Configure the settings of sensor size and focal length, and finally click OK.
During process, the process bar can be displayed under raw project.

3.1.9 Remove Project

Description
User can remove project data which include raw data, result data, preprocess data, adjust
data and refined data. If choose “Delete data” during remove, then the relative data folder
will be deleted.

Steps
Select node part under raw project list.
Click “Main – Project – Remove” or right click to remove current data.

Notes
For raw project, the delete option cannot be chosen by default. For processed data, user can
choose whether to delete during remove.

3.1.10 Project config

Description
Used for data processing for P330Pro with 3rd party camera.
Steps
Click ”Project Management→Config Project” in the main view, the Config Project window

will automatically pop up;
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Import base file, GNSS file, IMU file, click “Preprocess” to check whether the number of
photos and trigger are the same.
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Import CP file and image data.

Select the output directory, click “Start” to convert data, wait until the progress bar to reach
100%.
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3.1.11 Refresh Project

Description
User can refresh project if the raw project data changes.
Steps
Select project folder in list, then right click and choose “Refresh Project”.
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Notes
User can select RawWorkspace and right click, then choose “Refresh Project”. All projects will
be refresh together.

3.1.12 POS Accuracy Curve

Description
Check the accuracy metrics of pos.
Steps
Right click raw project to load pos accuracy curve.
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Float/Fixed Ambiguity Status: Accuracy of Fixed Status is higher than Float Status.
Fixed Ambiguity Status: Between 3 and 5.
Float Ambiguity Status: Below 3.
Quality Factor: According to the fixed ambiguity and estimation accuracy, range of values

from 1-7, the smaller the better.
PDOP: Position Dilution of Precision, which can reflect the distribution of satellites, range of

values from 0.5-99, the smaller the better.
Estimated Position: Represents the error of North/East/Height.
Estimated Attitude: Represents the error of Roll/Pich/Heading.
Combined Separation: Position difference values of forward and reverse solutions.
Attitude Separation: Attitude difference values of forward and reverse solutions.



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 26

3.1.13 Project Detail

Description
User can look over detailed information of project: laser data, camera data and GPS data.

Steps
Click “Main – Project – Info” or right click to view details.

3.1.14 Open Directory

Right click any nodes under task manager to open directory folder path.
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3.2 WindowManagement
User can manage how to display all windows in CoPre.

Layout: Click “Main – Window – Layout” , the software interface is displayed in the default
layout.

Resources: Click “Main – Window – Resources” , show or hide the resources window.
Trajectory: Click “Main – Window – Trajectory” , show or hide the trajectory window.
3D Viewer: Click “Main – Window – 3D Viewer” , show or hide the 3D viewer window.
Output: Click “Main – Window – Output” , show or hide the output window.
GCP: Click “Main – Window – GCP” , show or hide the GCP window.
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3.3 Vector Management
Description
The Vector Management Function includes importing, exporting, removing, and drawing
capabilities. The import feature supports importing KML, SHP, or DXF files to assist in
selecting tracks and modeling areas of interest. The export feature allows for exporting files
in SHP or DXF formats based on the selected trajectories.

3.3.1 Vector Import

Description
The import feature supports importing KML, SHP, or DXF files to assist in selecting tracks and
modeling areas of interest.
Steps
Click on "Home -> Vector -> Import";
After selecting a KML, SHP, or DXF file, click "OK," and the chosen file will be loaded into the

track view and 3D view;

3.3.2 Vector Export

Description
The export feature allows for exporting files in KML， SHP or DXF formats based on the
selected trajectories.
Steps
There are two ways to export vectors: exporting from loaded trajectories and exporting from
selected vector nodes.
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Method 1
Exporting from Loaded Trajectories: Choose the original project trajectories for export.
Display the original project trajectories in the trajectory view, select the trajectories you

want to export, and click on "Home -> Vector -> Export."
Click on "Export by trajectory", choose the file format (SHP or KML), and then select the

output directory to initiate the export.

Method 2
Exporting from Selected Vector Nodes: Select a vector node for export.
In task management, select the vect++or, then click "Home -> Vector -> Export".
Click on "Export by vector", choose the file format (SHP or DXF), and then select the output

directory to initiate the export.

3.3.3 Vector Removal

Description
This function is used to remove selected vectors.
Steps
In task management, select one or more vectors, then click "Home -> Vector -> Remove".
Confirm in the popup dialog to remove the selected vectors. You can check the option

“Delete Data” to delete the vector.
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3.3.4 Vector Drawing

Description
This function is used to draw SHP format vectors in the 3D view.
Steps
Step 1: Click on "Home-> Vector -> Draw";
Step 2: In the 3D view, use the left mouse button to click and draw. Right-click to access a

menu for cancel and redrawing. Click "End" to conclude the drawing .

Menu Description
End(Ctrl+E): The vector's starting point and endpoint automatically connect to form a closed
vector, completing the vector drawing.
Cancel(Ctrl+Z): Go back to the previous drawing step.
RedrawCtrl+Y): Proceed to the next drawing step.
Exit(ESC): Exit vector drawing.
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4 Trajectory View
Trajectory view interface can display POS trajectory and control points. User can select part
of trajectory by point, box, polygon or timeline modes. Meanwhile, it also supports measure,
meridian line display and base map display etc.

4.1 Display
Description
Display project or result trajectory. If project contains control points, it will also display with
trajectory on interface. This function can be used under both raw project, preprocess project,
adjust, refine, and result nodes.

4.1.1 Display Trajectory

Select a project on left bar, then click “Trajectory – ” or right click project to display POS
trajectory.

4.1.2 Hide Trajectory

User can uncheck the box of Pos to hide this trajectory.
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4.2 Selection
User can select trajectory by point, box, polygon, or timeline modes. The selected trajectory
will display red color. If select under RawWorkspace, only red part trajectory will be
processed; If select under preprocess workspace, only red part trajectory will load processed
point cloud data.

4.2.1 Point Select

Description
User can select trajectory via points or box.
Steps
Choose “Trajectory – ”. For point select mode, user can short click two points to select

the middle trajectory; For box select mode, user can long press left mouse to draw a
box and select relative trajectories.

4.2.2 Polygon Select

Description
User can draw a polygon to select trajectory.
Steps
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Choose “Trajectory – ” and use mouse to draw a polygon to select trajectory.
Left mouse: Draw a point of a polygon.
Double click: End the final point of a polygon.
Esc button: Withdraw to previous point.

4.2.3 Time Select

Description
User can select trajectory based on start time and end time.
Steps
Choose “Trajectory – ”. Set a start time and finish time then click ok.

4.2.4 Append

User can select multiple trajectories if check this option. Choose “Trajectory – ”.
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4.2.5 Inverse

Description
Default is uncheck this option, which means process selected trajectory. User can also switch
to inverse mode, which means process unchecked trajectory.
Steps
Check “Trajectory – ” option then select trajectory. The selected trajectory will be

displayed as black color.

4.2.6 Cancel Select

Description
User can cancel selected trajectory.
Steps
There are three different ways to cancel selection.
Remove the last selection
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Remove all selection

Remove current highlight selection

4.2.7 Measure

Description
User can measure trajectory length or multiple lines measurement.
Steps
Choose “Trajectory – ” and left click to select points on interface, and double click left

button to stop measure. Click “Measure” again can quit measurement mode.
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4.3 Slice

The slicing function of the track view supports the automatic display of slicing on the track
and the generation of slicing reports.

4.3.1 Auto Slice

Description
This function can be used on preprocess or result to show cut lines on trajectories to
determine point cloud overlap status.
Steps
Select target project node which contain point cloud data, then click “Trajectory – ”.

The overlap status will be displayed with different colors. User can configure the cut line
parameters in settings. Finally, user can click “Trajectory – ” to output screenshots
& reports.

4.3.2 Slice Analyze

Description
User can click each cut line to open a slice window to check overlap status.
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Steps
Display POS trajectory which contains point cloud data.
Check “Trajectory – ”, then choose any cut line to open a slice analyze window.

User can configure the slice width to update a new slice.
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User can click measure icon and hold left mouse to measure.

User can change the view to real ratio by click magnifying glass icon.
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4.4 Render

Set the display and rendering modes of POS track and point cloud on Track View and point
Cloud view

4.4.1 Render Set

This section describes how to adjust the trajectory view rendering, including adjusting the
trajectory rendering type and time rendering format.

4.4.1.1 Render Types
Description
CoPre 2 can display trajectory accuracy based on different attributes of POS: Quality factor,
calculated satellites, fix/float, PDOP, 3D accuracy, 2D accuracy and height accuracy.
Steps
Click “Trajectory - ” to select different attributes.

4.4.1.2 Time Format
Description
User can configure whether display UTC standard or absolute time.
Steps
Click “Trajectory - ”, user can choose whether UTC standard or absolute time.
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4.4.2 Map Settings

Adjust the Settings related to the offline map, including the display of the current track
longitude and the import of the offline base map.

4.4.2.1 Show longitude
Description
CoPre 2 can show current trajectory longitude with 3-degree or 6-degree.
Steps
Click “Trajectory - ”, user can see longitude on interface, and default is 3-degree.

4.4.2.2 Showmap
Description
Show trajectory on map. Online map need network connected; Off-line map need built a
server by enter address to download.
Steps
For online map, click “Trajectory - ”, the downloaded map will automatically be saved in

below path (.db3). Click “Trajectory - ” , the interface will show current location on
map. For off-line map, it supports two options to load: First, load offline map by
import .db3 file; Second, load offline map by server address.
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4.4.3 Layer

User can choose which layer need to be displayed on interface.

4.4.3.1 Show/hide GCP
Description
User can show/hide different types of GCP: Check points, paired points or GCP name.
Steps
After display trajectory, the trajectory view interface will show control points also. Click

“Trajectory – Layer – Refine points” to hide this layer on interface. User can click again
to activate display.
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4.4.3.2 Show/hide direction
Description
CoPre 2 can show or hide trajectory direction.
Steps
After display trajectory, user can choose to show or hide direction arrow on trajectory.

4.4.3.3 Show picture number
Description
CoPre 2 can show or hide picture number.
Steps
After display trajectory, user can choose to show or hide picture number.

4.4.3.4 Show base station
Description
CoPre 2 can show or hide base station.
Steps
After display trajectory, user can choose to show or hide base station.
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4.4.4 Display Point Cloud

Description
User can select trajectory to display point cloud. This function is activated by default.
Steps
After display trajectory, click “Trajectory - ”user can select processed trajectory to display

point cloud.

4.5 POS skip
Description
In the position where the vehicle data is parked for a long time (such as equal traffic lights),
the POS track may jump, resulting in the distortion of the laser data there. The POS jump
repair function can smooth the skip area to solve the problem of point cloud distortion.
Steps
When displaying the trajectory of the original project, pre-processing project, correction

project or adjustment project, the software will automatically detect the skip of the POS
data. If there is a skip, there will be a corresponding prompt in the output, and the jump
area on the track will be displayed in different colours.
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Right-click on the POS displayed in the task management bar, and you can choose to repair
POS

Set the relevant parameters in the pop-up repair POS dialog box, and click the confirm
button to start repairing POS.

Notes
Smooth Distance: Extend the threshold before and after the jump point for smoothing.
Detect Threshold：The actual size of the detected jump.
Convergence interval: Indicates the accuracy of POS repair
Time: POS skip repair area, which can be manually deleted or added
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5 3D View
Point clouds interface contains multiple functions: Point cloud render type, view, 2D/3D
switch etc. User can also make a slice or measurement based on point cloud data.

5.1 Point Cloud Colorization
CoPre 2 supports multiple colorization functions: Height, intensity, single, RGB and strip. User
can also configure the settings range and point size.

5.1.1 Color by Height

Click “3D View - ”,point clouds will be colored by height under this mode.

5.1.2 Color by Intensity

Click “3D View - ”,point clouds will be colored by height under this mode.
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5.1.3 Color by Height & Intensity

Point clouds will be colored by intensity & height together under this mode.

5.1.4 Color by number of returns

Click "3D View -> ," and the point cloud will be colored by number of returns.

5.1.5 Color by return number

Click "3D View -> ," and the point cloud will be colored by return number.
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5.1.6 Color by single project

Click "3D View -> ," and the point cloud will be colored by project, different projects will

be displayed in different colors.
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5.1.7 show/hide the colorbar

Click "3D View -> " to show/hide the color bar .

5.1.8 Color by Single

Click “3D View - ”,point clouds will be colored by different colors based on different files
under this mode.

5.1.9 Color by RGB

Click “3D View - ”,point clouds will be colored by real RGB color under this mode.

5.1.10 Color by Intensity & RGB

Point clouds will be colored by intensity & RGB together under this mode.
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5.1.11 Color by Strip

Click “3D View - ”,point clouds will be colored by different colors based on different strips.

5.1.12 Color Parameter Settings

User can configure parameters on “Settings”. Click “Reset” to restore default settings.



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 51

5.1.13 Points Size Settings

User can configure point cloud size based on these settings.

5.2 View Settings
User can switch multiple view angles to display point cloud data on interface.

5.2.1 2D/3D Switch

Click “3D View - ”,this function support 2D and 3D view switch displaying, and default is
3D display. Click it again to switch 2D view.
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5.2.2 Direction

CoPre 2 supports multiple eye view directions: Front, back, left, right, top and bottom.

5.2.3 Full Extent

User can “3D View - ”, to display point cloud data at center by default.

5.3 Point Cloud Clipping
Description
This function is used for point cloud clipping to remove noise.
Steps

Click "3D View -> " to activate the clipping command, and the clipping mode window
will pop up.

Icon Description
Rectangle box selection: Select point cloud data by dragging the mouse to create a

rectangular selection box.
Polygon box selection: Select point cloud data by clicking the mouse to draw a polygonal

selection box.

Remove Selection: Remove selected point cloud data by dragging the mouse to create a
rectangular selection box.

Interior clipping: Keep the point cloud within the selection box
Exterior clipping: Keep the point cloud outside the selection box.
Clear：Undo the selection or clipping.
Save；After saving the clipped point cloud data, overwrite the original point cloud data.
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Select the rectangle (or polygon) box selection tool, draw a rectangle (or polygon) on the
point cloud, and then click on " Interior clipping " (or " Exterior clipping ").

Point cloud before clipping:

Point cloud selected by Box:

interior clipping:
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Exterior clipping:

Click "Save," then click "Confirm" in the pop-up window. When the progress bar reaches
100%, it indicates that the point cloud clipping is complete. After clipping, the point
cloud data in the project will be overwritten and automatically reloaded into the 3D
view.

5.4 Measurement
Measurement tool includes point measurement, density measurement, distance
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measurement, and area measurement.

5.4.1 Point Measurement

Description
This function is used to measure the coordinates, RGB, intensity, time, echo, scan angle, scan
direction, and point source ID of a point cloud.
Steps

Click "3D View -> " to activate the measurement command. Select "Point

Measurement" from the pop-up menu to open the point measurement window.

Click on a point , and the measurement information for that point will then appear.

Note: Point measurement is only effective for measuring the point cloud.

5.4.2 Density Measurement

Description
This function is used to measure the density of the point cloud.
Steps

Click "3D View -> " to activate the measurement command. Select "Density

Measurement" from the pop-up menu to open the density measurement window.
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Set the length, then click on the point cloud you want to measure. The point cloud density
information within the red box will be displayed in the window.

Note: Density measurement is only effective for measuring the point cloud.

5.4.3 Distance Measurement

Description
This function is used to measure distance.
Steps

Click "3D View -> " to activate the measurement command. Select "Distance

Measurement" from the pop-up menu to open the distance measurement window.
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Step 2: Measure the distance on the point cloud by clicking with the mouse to start drawing
a line and double-clicking to finish the line segment.

5.4.4 Area Measurement

Description
This function is used to measure area.
Steps

Step 1: Click "3D View -> " to activate the measurement command, then select "Area

Measurement" from the pop-up menu.

Step 2: Click to select points and double-click to finish drawing a closed region on the point
cloud. The region will be highlighted, and the area will be displayed.
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5.5 Select
Description
User can use this function to pair GCP with point cloud data. Activate by default.
Steps
Click “3D View - ” to activate this function, then select point on interface. There are
three ways to select:
First, use “Ctrl” button and left mouse to select.

Second, use “Shift” button and left mouse to draw two cross lines to select (press Esc
button to cancel selection).
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Third, use “Alt” button and left mouse to draw three points to design a circle, and circle
center point will be selected automatically.

5.6 GCP Display
Display
User can display or hide GCP information on interface.
Steps
Click “3D View - ” to display or hide GCP.
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5.7 Trajectory Display
Display
User can display or hide trajectory on interface.
Steps
Click “3D View - ” to display or hide trajectory.
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5.8 Slices
User can make a horizontal slice based on point cloud data, which can display all points on
this elevation.

5.8.1 Hz Slice

Steps
Click “3D View - ” and click mouse wheel to select a location first. CoPre 2 will generate a

section based on this elevation and left bottom interface will display this elevation.

Shortcut key: “Q”: Open, “E”: Exit clip mode. Press Ctrl and mouse wheel to move section.

5.8.2 Vertical Slice

Description
Click “3D View - ” .User can check point cloud thickness or overlap via a vertical slice.

Steps
Check “V Slice”, then left mouse to select two points to create a vertical slice. Press “Esc” to
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cancel.

5.8.3 Clip Param Settings

Description
Click “3D View - ”. User can configure thickness settings on horizontal & vertical
directions.
Steps
Configure settings and finally click confirm to save
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6 GCP View

This chapter describes operations related to the control point window. It includes importing
control points, selecting matching points, checking control points and other operations.

6.1 Import GCP
User can import GCP under raw project node, pretreatment node and result node. GCP can
be used to refine trajectory or test absolute accuracy finally.

6.1.1 Import by control point file

CoPre 2 supports txt or csv formats file import, and make sure each line is kept
corresponding. Both NEH and BLH (degree.degree & degree, minute, second) format can be
read.
Steps
Click “GCP window - Import GCP” to import GCP file.

After import, use “Separator” to divide contents. Make sure the column number is
corresponded to their contents (Name, E, N, H etc).
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Click “OK” to import GCP.
After import successfully, both trajectory & point cloud interface will display imported GCP

data.

Notes
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If the control point file has update, support repeat import and it will cover old same name
points.

6.1.2 New GCP

Description
This function cannot be used on raw project node. Need select new GCP on point cloud. This
function is mainly used for two-way road data, and user can choose one side high accuracy
data as control points to calibrate another side. When use such function, make sure both
two-way scanning data contain this new GCP.

Steps
Load solved project’s trajectory and point cloud data first, then click “GCP window - Add

GCP” on right side.
Activate “Select” function and press “Ctrl” button, then click left mouse to select point (Or

Shift button with left mouse to select two lines for fitting). The coordinate will
automatically appear after selected, finally click confirm and it will present as yellow
color.

6.2 Select Matching points

The selection of matching points is to select points on the point cloud and match them with
control points. Before the operation of correction and result accuracy verification, the
selection of matching points should be carried out first. Elevation matching points can be
automatically added using elevation matching points, while plane matching points and
three-dimensional matching points need to be manually added.
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6.2.1 Import paired point manually

Activate “Select” function, then select paired point on interface: Press “Ctrl” button and left
mouse or “Shift” button and left mouse to draw 2 lines for fit, or “Alt” button and left mouse
three time to draw a circle center point , then press “Crtl” button with right mouse to input
relative control point name and refine type, finally click confirm. The paired point display as
blue color.

6.2.2 Height Matching

Height point matching is an automated process and no need to select point manually. But
this function is only suitable for height points matching (This function is mainly useful for
highway data).

6.2.3 Point Type / Correction Type Settings

Set point type: User can set points as check point and generate accuracy report. The
interval between two neighbor check points is about 100-150 m.
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6.3 Check Control Point

This section describes how to use the imported control points to check the annotated check
list, including using the control point photo to check, checking matching points and
controlling point-to-point information.

6.3.1 Display GCP Pictures

Description
This function cannot be used on raw project node. User can easily select paired point based
on GCP pictures.

Steps
First, named pictures as GCP name and save all pictures under one folder.
Click “Display GCP picture” and choose picture folder path to import. Import GCP name and

display relative pictures. Roll mouse wheel can zoom in or zoom out pictures.
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Notes
If add new pictures, need re-import path to view the new pictures.

6.3.2 Check Paired Point

Description
This function is used for control points and paired points checking. If neighboring control
point interval exceed threshold (default 100 m), then it will be considered as abnormal
control point and display as red color; if neighboring paired point error exceed threshold
(default 0.05 m), then it will be considered as abnormal paired point and display as orange
color.

Steps
Click “Matched Point Check” on GCP window. When process is done, a report will be

automatically generated.
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User can also click “Chart” to view the linear chart of result. If it contains wave peak or
wave valley, it might be the large error point and need to check whether need re-select
point for matching.

6.4 Control Point Other Functions
Search control point: CoPre 2 supports search function if there are multiple GCP contained.

Copy control point: select one control point on the list, then right click copy. A new copy
point will be added with “copy” suffix.
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Delete control point: select one control point or multiple control points from the list
(Ctrl+left mouse for multiple operation, Ctrl+A for all selection). Right click delete.

Delete paired point: select one or multiple paired control points from the list (Ctrl+left
mouse for multiple operation, Ctrl+A for all selection).

Trace control point: this function can quickly locate to target control point and zoom on.

Show only the control points within the current POS range
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7 Processing

This chapter introduces the main data processing process of copre software, as shown in the
figure below

7.1 POS Solve
Description
If the raw project does not contain POST file, then user need to process POST file first.

Notes
CoPre 2 use CHCNAV own algorithm to process POST. It supports two types of base static
data: HCN format and RINEX 3.02 format.

7.1.1 Operation steps

Steps
Select target project under task manager list, then choose “Processing– POS”
If the Base folder contain static data (HCN or RINEX 3.02), then software will load it

automatically. User can also manually add or delete extra base station data by click “Add”
and “Remove”.
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Settings for loosely coupled and tightly coupled algorithms
There are two algorithms for POS processing: loosely-coupled mode and tightly-coupled
mode. The loosely-coupled mode is suitable for airborne open environments, while the
tightly-coupled mode is suitable for complex automotive environments.
The software will automatically select the appropriate processing mode based on the type of
data. For airborne data where the performance of the loosely-coupled processing mode is
not satisfactory, the tightly-coupled mode can be used as an alternative solution.

Notes
When multiple groups of data base station data are the same, after modified the base
station coordinate, antenna settings or ephemeris data settings of a data, can click "Batch
Settings" to modify the base station coordinate, antenna settings and ephemeris settings of
other data in batches.
User can configure “Enabled” option for different base stations to decide use or not use.
Users need to set base station at a known coordinate, then manually input coordinate to

get accurate result.
Finally, click “Ok” to start POS process.

When processing data from AP5, check the POS optimization function, use SLAM and INS
tightly coupled solution to improve POS accuracy, can repair POS jumping.
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7.1.2 Add / Remove bases

Description
If the base file is RINEX 3.02 format or HCN format, users can manually add or remove base
stations.
Steps
Click ”Add”, select the base station file, click “Open”, and the software will load the base

station file selected by the user.

Select the base station to be removed, Click ”Remove”.
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7.1.3 Set base coordinate

Description
In order to ensure the absolute accuracy of the result data, the solving needs the accurate
coordinates of the base station.

7.1.4 Antenna Settings

Description
If the base file is HCN format, user can configure the antenna settings; If the base file is
RINEX 3.02 format, user can only configure “Antenna Height”.

Measured height: Height from ground control point to base receiver. Input antenna height
before static record will be read here automatically.

Measure to: Configure 4 different method ways: slant height, vertical height, phase height
and unknown.

Manufacturer & type: Receiver type, read from HCN file.
Sampling Rate: Static rate, read from HCN file.
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Antenna Height (to phase center): If the base file is HCN format, this value is automatically
calculated based on measured height, measure to and receiver antenna type, cannot
manually change; If the base file is RINEX 3.02 format, this value can be changed
manually.

7.1.5 Select From Library

Description
User can save used base coordinate into library, or directly select from library.
Steps
After input base coordinate, user can click “save to library” for storage. Set the base name,

coordinate, description and finally click “Save”.

User can click “Select” to load stored base coordinate for next time using. Click “load” to
import base information for POS process.
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The base library file will be saved with .db suffix, and the default path is
D:/BaseStationLibrary.db. User can also change the path & name for storage.
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7.1.6 Ephemeris Data

User can click “More” to configure constellation system based on requirement: GPS, Beidou,
GLONASS, Galileo and QZSS.

In the “Settings” interface, click the “More” button, then you can see the “Advanced
Settings”, where you can set whether to enable the “Atmospheric Estimation” and “Add
Accel/Gyros Scale”.

□Add Accel/Gyros Scale: Enabling this setting can solve the errors calculated by the IMU.
Accelerometer and Gyro Extra States. These options add scale and/or non-orthogonality
states to the Kalman filter for the accelerometer and gyroscope measurements. They are
often needed by MEMS sensors to account for errors in the manufacturing process.

□Atmospheric Estimation: If the base station is far from the survey area, it is recommended
to enable this setting to improve pos accuracy.

7.1.7 Generate POS Report

Description
POS report can be used to check the quality of POS accuracy.
Steps
Select raw project on list, then right click to generate POS report.
When the POS report generated successfully, can right-click "Open POS Report" on the

original project to open the POS report.
The POS report is as follows:



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 78

Note： For airborne data, please display and select the track before displaying the POS
accuracy report.

7.2 Data Solve
Description
Generate final output results: point cloud, picture, depth map, colorization. The output
result data is saved under Results folder.

Steps
Select target project (raw, preprocess, adjust or refine) on list, then click “Processing –

Result” or right click to output result data. CoPre 2 design a set of different parameters
for each type of project, user can directly output result or configure the settings first.
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7.2.1 Organize Pictures

CoPre 2 can output organized pictures.

Time delay: Default is 0. if exist time delay can change this setting.
Move pictures: Default check, cannot cancel.
Write EXIF: Default uncheck, this function can write position & altitude information on

pictures.
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7.2.2 Point Cloud Processing

Check the option of “point cloud processing” then the software will process laser data.
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7.2.2.1 Filter settings
User can configure the filter settings before start process, which includes static filter and
laser filter.

Static filter settings: not used by default. The default speed limit is 0.01 m/s and duration
are 10 sec. Software will consider such data as static data to filter based on settings.
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MTA settings: not used by default and this option only appear when process Riegl head data.
User can choose whether use MTA to process.

Circle Noise Filter: The filtering is low by default. If there is still noise after solving with MTA,
you can set ring noise parameters, and there are low, middle and high-grade bits to set.

Field angle filter: used by default. The default angle is 90 degrees, which means 45 degrees
for both left and right side, and filer out of range point cloud data.

3D distance filter: used by default. This function will filter the out-of-range points.

Intensity filter: used by default. This function will filter the out-of-range points.

Height distance filter: not used by default. This function will the out-of-range points. The 0
is at the center of LiDAR and upper direction is positive.
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Noise filter: not used by default. This function will filter the jumping noise points.

2D distance filter: not used by default. This function is used to filter point cloud data based
on strip width to set overlap.

7.2.2.2 Sampling rate
CoPre 2 can set the sampling rate through the drop-down box at the sampling rate, and the
sampling rate can be set to 25%, 50%, 75%, 100%. Where the default sampling rate is 100%,
which means no sampling.

7.2.2.3 Colorization settings
CoPre 2 can colorize point cloud data based on pictures after check “Coloring” box.
RGB range: default is 0-65535, also supports 0-255.
Remove unshaded points: default is not used. The non-colorized points will be deleted if

check this option.
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Filter tower shadow: default is used. This function can solve the tower wrong colorization
issue. For vehicle data this option is not work.

Trigger filter interval & Cover radius: default values are 10 m and 8.5 m. User can configure
a bigger value if faced wrong colorization (front & rear block) for vehicle data.

Mask file: this function is only worked for vehicle data. User can import mask pictures to
filter vehicle body on panoramic pictures.
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Camera name: If one project contains multiple sets of camera data, user can select camera
based on name and software will use this set of pictures to colorize point cloud.

7.2.3 Depth Map

This function is only available for vehicle data and not checked by default. When both
panoramic picture and point cloud were processed done, user can choose to create depth
map.
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7.2.4 Generate Result Report

Generate Results Report：when generating the results, a result report will be generated.
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The result report includes four parts: project summary, process overview, picture overview
and point cloud overview. The result report is as follows:
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7.2.5 Other Settings

Batch settings: this function can set all projects to a set of same parameters.
Output directory: default path is Results folder and user can configure it.
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7.2.6 View Result

Description
After process finished, user view Codata format point cloud data in CoPre 2.
Steps
Select target node then click “Trajectory – ” to load mission. Click on two points or hold

left button to select trajectory, then the relative point cloud data will be displayed.
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7.3 Strip Adjust
Description
Adjustment function mainly solves the problem of data inconsistency and improves the
accuracy of data; CoPre can adjust data from both airborne and vehicle-mounted platforms.

7.3.1 Adjust airborne data

Steps
Process the original project in the workspace node and generate the results in the

resultworkspace node.
Right-click project name in the resultworkspace node and select “Strip Adjust” or click

“Processing”→”Strip Adjust” in the main view.

Set adjustment parameters, select the POST modification mode.
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Block Size(m): Block the point cloud according to the block size.
Grid Size(m): This parameter is used for resampling point clouds, thin the point cloud within

the grid to one.
Note: Resampling can speed adjustment up and will not reduce point cloud after
adjustment. However, do not set the value too large, which may lead to loss of key
points.

POST modification mode:There are three modification modes:Change Position,Change
Attitude, Change Position And Attitude.If there is no problem with POST position or
attitude accuracy, you can choose to change another item; If not sure, you can choose
to change both.

After setting the parameters,click”OK”, CoPre will do the adjustment automatically.
After adjustment is completed, the adjustment report will pop up, and generate new POS,

point cloud, and log files in the ADJUST folder in the task path.

After adjustment is completed, the adjustment report will pop up, and generate new POS,
point cloud, and log files in the ADJUST folder in the task path.
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After adjustment is complete, the corresponding adjustment node is generated under the
resultworkspace. Users can load the point cloud after adjustment to view it. For details,
please refer to 7.2.6 Viewing Results.

7.3.2 Adjust vehicle-mounted data

Steps
Process the original project in the workspace node and generate the results in the

resultworkspace node.
Right-click project name in the resultworkspace node and select “Strip Adjust” or click

“Processing”→”Strip Adjust” in the main view.
Set adjustment parameters, select the POST modification mode.

Block time interval(s): Block the point cloud according to the set time interval.
Grid Size(m): This parameter is used for resampling point clouds, thin the point cloud within

the grid to one.
POST modification mode:There are three modification modes:Change Position,Change
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Attitude, Change Position And Attitude.Change Position And Attitude is selected by
default, can get good result but it takes a long time.Change Position can be selected,
high efficiency,but cannot get very good result.Change Attitude only is not
recommended.

Smoothing time(s): According to the smoothing time, the point clouds at the beginning and
end of the time range are smoothed to ensure that there is no fault in the joint part of
the adjusted point cloud and the unadjusted point cloud.

Adjust Selected Time Areas: When checked, only point clouds within the time range of the
selected trajectory are adjusted.
Note: CoPre can adjust vehicle-mounted data between multiple projects.

After setting the parameters,click”OK”, CoPre will do the adjustment automatically.

7.4 GCP Adjust
Description
Refinement can reduce the error in a certain range and improve the absolute accuracy of
point cloud.

Steps
Process the original project in the workspace node and generate the results in the

resultworkspace node.
Import control points and select matching points on results or adjustment nodes.
Right-click project name in the resultworkspace node and select “GCP Adjust” or click

“Processing”→”GCP Adjust” in the main view.
Set refinement parameters.
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Mode 1: Just refine position only, will reprocess pos, used for data that does not require
high accuracy of attitude.

Distance Threshold (m) : If the distance between control points is less than the set
threshold, then the pos position refinement value is calculated according to the
adjacent control points.During refinement, the point clouds between the selected
points will be refined, and the point clouds within the smooth threshold before and
after the selected points will be smoothed.

Smooth Threshold (m): If the distance between control points is more than the set
threshold, the data will be smoothed.

Mode 2: Refine both position and attitude, will reprocess pos, used for data that requires
high accuracy of attitude.

Mode 3: Refine point cloud (base on near control point error),the point cloud refinement
value is calculated by interpolating the error of adjacent control points.

Mode 4: Refine point cloud (point cloud overall offset), the whole point cloud is rotated and
offset.
Note:
When choose different refinement mode, the algorithm schematic diagram and
recommended usage scenario are displayed in the software window. Users can choose
the refinement mode according to the actual situation of the data.

Click “OK”, CoPre will do the refinement automatically, and generate the results in the
resultworkspace node after refinement is completed.
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If user selects checkpoint when selecting control points in the result or adjustment node,
will generate accuracy report after refinement. Right-click the refinement node to check
the report.

7.5 Export Results
Description
Can export point clouds, photos and colored point clouds in the result, adjustment,
refinement nodes.
Steps

Process the original project in the workspace node and generate the results in the
resultworkspace node.

Right-click project name in the resultworkspace node and do adjustment or refinement.
Right-click the result, adjustment, or refinement nodes to select “Export Results” or click

“Processing”→”Export” in the main view.
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Select to output point clouds , images or both, set the output directory, and click “OK”.

Right-click the project node to open the path for exporting results.
Coordinate Type: Can select projected coordinate system, geodetic coordinate system,

space rectangular coordinate system, topocentric coordinate system.
File Format: Can output point cloud in las, laz, e57, pts format.
Version: For point clouds in las and laz formats, there are versions 1.2, 1.3, and 1.4; There is

only one version in e57 and pts format.
Output Directory: The default output directory is...Results\Export folder, user can also

change the path.Right-click the project node can open the path for exporting results.

7.6 Pause & Cancel
During data process, user can pause or cancel the processing step. After pause, user can click
continue to keep start work.

8 Reconstruction

This chapter describes the main process of reconstruction. These include AT, Mark, DOM,
and Model
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8.1 Aerial triangulation
Description
The image results generated by processing module can do AT processing, which can be used
for GCP mark, DOM building and model building.
Steps
Select the result node generated in the preprocessing module (needs to contain image

data), click “Reconstruction -> AT”.
The AT dialog box will pop up, as shown in the figure below, select the scene.
Set the plane and height accuracy respectively.
Click OK to start the AT processing.

During the AT processing, the progress bar will be displayed below the result node. When
the progress bar reaches 100%, the AT processing is completed, and the corresponding AT
node will be added to the Resources.
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After the AT processing is completed, you can right-click the AT node and select Show
Connection Point to check the matching of the image track and image after AT.

Notes
The image POS after AT is displayed as green color, and the image matched points are
displayed as RGB color
After the AT is completed, you can right-click the AT node and select “AT Report” to view the

AT report.
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8.2 GCP Mark
Description
Import the image control points and mark the image, can optimize the AT and improve its
absolute accuracy.
Steps
Select AT node, click "Reconstruction -> Mark".

Import control points in the GCP Management view, you can see the total number of
pictures corresponding to the control point.

Double-click the control point need to be marked, the software will load the pictures
thumbnail corresponding to the control point.

Click to select a picture in the thumbnail window, the selected picture will be loaded into
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the Mark View, use "Ctrl + left button" to mark the point.

After a picture has been marked, the checkmark at the corner of the picture will turn green,
indicating that the picture has been marked.

After the control point marked more than two pictures, the number of marked pictures and
the marked error will be displayed in the control point list, and the control point will be
automatically checked

Notes
Only the checked control points will participate in the Aerial triangulation optimization.
When all control points are marked, you can click “AT Optimization” to optimize the current

AT node.

8.2.1 GCP Match

Description
During the GCP marking. If more than two pictures are marked, the software will predict the



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 101

position of the control point on unmarked picture. If the predicted location is very accurate,
you can use the “GCP Match” function to automatically mark the unmarked pictures.
Steps
After marking more than two pictures, the control point position of other pictures will be

predicted.

Click the “GCP Match” button, the software will automatically check all the pictures without
marked.

If you find that some pictures have inaccurate marked results, you can click the check mark
of the picture thumbnail, the green check mark will turn black, indicating that the picture
will not participate in the AT optimization processing.

8.3 Build DOM
Description
DOM result is generated from image data, which can be generated at the result node or the
AT node.
Steps
Select a result node (need to contain image data) or AT node, click "Reconstruction ->

DOM".
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Set the relevant parameters in the pop-up window, click OK, the software will start DOM
processing.

Data source: Select according to the corresponding data, the lidar can only be selected in
the high-efficiency mode, and the image is a required option.

Mode settings: Contains two modes: high efficiency and high quality. High efficiency
generates DOM faster, but the effect is poor, and high-quality generates DOM at a slow
speed and better effect.

Scene settings: There are three scenes including city, mountain and plain, which can be
selected according to the actual data scene type.

DOM setting: If you check adaptive resolution, the software will automatically calculate the
resolution of the DOM, if you check custom resolution, the software will output the DOM
according to the set resolution.

Note
1. If the DOM is generated at the AT node, only resolution setting can be selected, other
settings are not visible;
2. In the high-efficiency mode and the data source of lidar is selected, the AT processing will
not be performed, and the scene settings will not be visible.
After the DOM processing is completed, the corresponding DOM node will be generated.

You can right-click the DOM node to select load DOM, and the software will automatically
load the DOM data corresponding to the current node.
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8.4 Build Model
Description
Model result is generated from image data, can only be generated at the AT node.

8.4.1 Single Mode

Steps
Select a AT node, click "Model".

Set the relevant parameters in the pop-up window, click OK, the software will start Model
processing.

Model settings: Including tile settings, coordinate origin settings, block settings, and output
DOM.

Data source: Select according to the corresponding data, Lidar can be checked, image data
source is required;

Process mode: Includes single-machine deployment mode and cluster deployment mode.
Tile: There are two methods: adaptive and custom. When "adaptive" is checked, the

software will automatically calculate the appropriate tile size according to the current
remaining memory of the computer. When "Custom" is checked, the software will
calculate the required memory consumption according to the current size of the tile and
click the "Confirm" button on the right.
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Output DOM: When building model, you can output DOM incidentally. When checked, the
DOM data will be output after the model is built.

After the Model processing is completed, the corresponding Model node will be generated.
You can right-click the Model node to select load Model, and the software will
automatically load the Model data corresponding to the current node.

8.4.2 Cluster Mode

Steps
Select a AT node, click “Model”.

Select the “Cluster Mode” and click “Settings” to pop up the cluster settings dialog box,
which will automatically read the machines in the local area network with the cluster
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service turned on, where the node IP and cluster ID is displayed on the left. Click the
machine IP that needs to be the child node of the engineering task, click “Add” to join the
node, and click “OK” after the configuration is finished.

Node status: Used to view the running status of each node.
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Task status: Used to view the overall running status of the task.

8.4.3 ReMode

Steps
Click ”ReModel” on the model node

Notes:
The modeling data needs to be reloaded after remodel.
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9 Tools

9.1 Data Copy tool

The data copy tool can automatically copy raw data from the device.

Steps：

Different devices have different data storage disks. For details, please refer to the user
manual of the actual device in your hand.

Connect the data storage card with card reader to the computer, the computer will pop up
disk ALPHA_SYS.

Connect the camera to the computer with the type-C cable, the computer will pop up two
disks: CAM_M and CAM_SYS.

Click“Tools->Data Copy”；

Select the corresponding parameters：
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For current AU20, AlphaPano and AA10 units, please manually select the mount carrier
before data copy.

If you have selected the user defined carrier type option, you need to manually set the
parameters.

Set parameters as shown below.For details, please refer to the user manual of the actual
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device in your hand.

After setting up, you can check the project data of the device in the data column on the left.
Select one or multiple sets of data, and you can see the corresponding camera, laser
and GPS data on the right side.

Notes
Double-click on a photo to view the current photo.
Create the directory and select the copy path.
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Click the copy button, CoPre will automatically copy the selected sets of data.

After all sets of data are copied or the storage space is insufficient, you can click the format
icon in the upper right corner to format the disk.
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9.2 Data quality check
Description
Used to detect data loss and jump of Lidar and IMU, and detect whether the images are
missed.
Steps
Click ”Tools→Data Check”, the data check window will automatically pop up;

Click “Import” button to import the data to be checked;

Check the items to be checked, including Lidar data, camera data and IMU data,then
click ”Check”button.

Wait until the progress bar reaches 100%, click can open the “Source Data Quality

Report”, as follow:



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 114

Import：Import the data to be checked, can import multiple projects at the same time.
Lidar data check:

(1) AA450(lv、pcap format)：If the data packet is lost for more than 100 and time jump
more than 0.0125s ,Copre decides there is a problem with this data.
(2) Hesai XT16、Hesai XT32(pcap format)：If the data packet is lost for more than 100
and time jump more than 0.02s(XT16) , 0.01s(XT32),Copre decides there is a problem
with this data.
(3) Riegl：If the data packet is lost for more than 1 and time jump more than 0.3s ,Copre
decides there is a problem with this data.
(4) LT：If the data packet is lost for more than 1 and time jump more than 0.1s ,Copre
decides there is a problem with this data.

camera data check:
Check the CHCNAV self - developed camera and Ladybug camera to see if the number
of photos and TRG is the same.

IMU data check: If the Imr data packet is lost for more than 1 second and time jump
exist,CoPre decides there is a problem with this data.

Check：Click ”Check” button to start checking data.
Delete：Right-click the imported project to delete the selected project.
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9.3 POS Optimize
Description:
When processing data from AP5, check the POS optimization function, use SLAM and INS
tightly coupled solution to improve POS accuracy, can repair POS jumping.

Steps:
Click Tools→POS optimize;

Choose the project file path, and CoPre will automatically detect the paths of the Post file
and IMU file.

Check if the automatically selected post file is the one to be optimized. Once confirmed,
click "OK".

After the progress bar is completed, a Post file with the _SLAM suffix is generated under the
selected Post file path, that is the optimized file.

9.4 Point cloud thickness optimization
Description
Only used for data from AA450（AA450Pro）、Alpha3D、VA3 and AU10, can reduce the
thickness of point cloud.
Steps
Click ”Tools→Point Cloud Optimize”, the Point Cloud Optimize window will automatically
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pop up;

Set Coordinate Type and Carrier Type.
Import the point cloud that needs thickness optimization, can import las, laz, and codata

format.
Set thickness optimization parameters, including Grid Sampling,Grid Size (m),Max Thick

(m),Merge Files and File Formart, please see detailed parameter description below.
Set Output Directory.
Click Start to start thickness optimization，wait until the progress bar reaches 100%, can

check the result in the PointCloudRefine folder of the Output Directory path, as follow:

Coordinate Type: Can select projected coordinate system, geodetic coordinate system,
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space rectangular coordinate system, topocentric coordinate system ,the default is
projected coordinate system.

Carrier Type: Can select UAV or Carset,the default is UAV.
PosL File: Point cloud form car set need import PosL file.
Source Files: Import the point cloud that needs thickness optimization, can import las, laz,

and codata format.
Grid Sampling: Check by default.
Grid Size (m): Need to check Grid Sampling first, the bigger the value, the less the point

cloud.
Max Thick (m): He upper limit of point cloud thickness that the algorithm can optimize, the

optimization result may not be good for point cloud whose thickness exceeds this value.
Merge Files: Check by default, point cloud after thickness optimization will be merged into

one file.

9.5 Points Optimize Tool

Description

This tool can only be used for AA10, AA450 (AA450PRO), Alpha3D, VA3, and AU10 data, and
this tool can effectively reduce the thickness of the point cloud;
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9.6 CS Manager tool

The “CS Manager” tool is mainly divided into two parts which are parameter calculation
and coordinate conversion, and they separately support coordinate conversion parameters
calculation and point coordinate conversion between different coordinate systems.

9.6.1 Coordinate conversion

Main functions

Click the “CS Manager” tool, then the coordinate conversion window named “CoCoord”
pops up .

The coordinate conversion contains five function bars which are “Source Coordinate
System”, “Conversion Method”, “Target Coordinate System”, “Source Coordinates” and
“Target Coordinates”.

Description

1. According to the different types of coordinate system, the types of the

coordinates are divided into spatial rectangular coordinate (XYZ), geodetic coordinate (BLH)
and projection coordinate (NEH). When conducting the coordinate solution operation, it
should be noted that the source coordinate system needs to be in the same format as the
coordinates of the known points, and the converted coordinate format needs to be same as
the format of the target coordinate system;

2. There are four types of conversion methods, which are datum transform, plane

calibration, elevation fitting and grid method:
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(1) Datum transform is converting the three values of x, y and z, and the methods
include “Three Parameter”, “Seven Parameter” and “Strict Seven Parameter”;

(2) Plane calibration is converting the two values of x and y, and the methods include
“Four Parameter” and “TGO Horizontal Adjustment Method”;

(3) Elevation fitting is only converting the value of z, and the methods include “Fixed
Error Correction”, “Plane Fitting” ,”Curve Fitting” and “TGO Horizontal Adjustment Method”;

(4) The gird method is dividing the plane into different blocks with the same size and
different elevations, and using the grid file can interpolate the coordinate points according to
the grid to obtain the elevation data of corresponding points.

Steps
Open the “CS Manager” tool, and then set the coordinate types of the source coordinate

system and target coordinate system;
Click the “Coordinate System Settings” button for the source coordinate system, set the

coordinate system for the original coordinates. As the following picture shows, the set
coordinate system is WGS84/geodetic coordinates;

Click the “Coordinate System Settings” button for the target coordinate system, set the
coordinate system for the conversion target, at the same time input the parameters
used for coordinate conversion. After all the settings are set, click the “Confirm” button;

After clicking the “Confirm” button, you can see the conversion parameters that have
been enabled in the “Conversion Method” part;
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Click the “Load point/point cloud files” button to import files, or you can also manually
input the point coordinates before conversion;

Click the “Convert Coordinate” button, then you can obtain the converted points or point
clouds;

At last you can directly copy the concerted result from the current interface or click the
“Export” button to export the result;

Matters needing attention

1. In scenarios where the projection coordinates are converted using different ellipsoids, the
datum transform method should be adopted.

(1) Processing process

Convert projection coordinate to spatial rectangular coordinate under the original
ellipsoid, then adopt the datum transform method to convert the spatial rectangular
coordinate under the original ellipsoid to the spatial rectangular coordinate under the target
ellipsoid, at last convert the spatial rectangular coordinate under the target ellipsoid to
projection coordinate.

(2) The reason why it is necessary to convert to the spatial rectangular coordinate for
datum transform:

Because the ellipsoidal parameters of different ellipsoids are different, but the
projection coordinate is the projection transformation result under a certain ellipsoid. If
directly using the “Four Parameter” method to conduct the coordinate conversion operation,
the converted coordinates may be wrong; Similarly, when using the “Four Parameter”
method, the operation must be conducted under the same ellipsoid.

2. The already set and used conversion parameters will be displayed in the “Conversion
Method” part in the main interface, before the coordinate conversion operation please
confirm the conversion method to be used;

3. Switching the type of the conversion coordinate or importing the point cloud will empty
the existing coordinates, so before the coordinate conversion operation please confirm the
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coordinate type is correct;

4. When the type of the original coordinate is projection coordinate, the projection mode
can be switched in the “Coordinate System Settings”, but other coordinate types do not
support this function currently.

9.6.2 Parameter Calculation

This function is used to calculate the conversion parameters. After clicking the
“Calculate Parameters” button, the “Calculate Parameters” window pops up .

Parameter calculation

Description

1. Parameter types and calculation methods

The types of parameters include ellipsoid transform parameters, plane transform
parameters and elevation fitting parameters.

(1) Ellipsoid transform parameters: including “Three Parameter”, “Seven Parameter” and
“Strict Seven Parameter”;

The “Three Parameter” method requires the coordinates of at least one pair of known
points, and is generally used on the area with a small scale. The accuracy of this method
depends on the scope of the task area and decreases as the working distance increases;

The “Seven Parameter” method requires the coordinates of at least three pairs of
known points and the application range is larger, generally greater than 50 kilometers;

The “Strict Seven Parameter” method requires at least four pairs of known points;

(2) Plane transform parameters: including “Four Parameter” and “TGO Horizontal
Adjustment Method”;
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The “Four Parameter” method requires the coordinates of at least two pairs of known
points to calculate the four parameters which are “North translation”, “East translation”,
“Rotation angle” and “Scale factor”;

The “TGO Horizontal Adjustment Method” method requires at least three pairs of
known points to calculate the six parameters which are “North origin point”, “East origin
point”, “North translation”, “East translation”, “Rotation angle” and “Scale factor”;

(3) Elevation Fitting Parameters: including “Fixed Error Correction”, “Plane Fitting”, “Curve
Fitting” and “TGO Horizontal Adjustment Method”;

The “Fixed Error Correction” means translation, and this method requires the
coordinates of at least one pair of known points to calculate the parameter “Fit parameter
A”;

The “Plane Fitting” method requires the coordinates of at least three pairs of known
points to calculate the three parameters which are “Fit parameter A”, “Fit parameter B” and
“Fit parameter C”;

The “Curve Fitting” method requires the coordinates of at least six pairs of known
points to calculate the six parameters which are “Fit parameter A”, “Fit parameter B”, “Fit
parameter C”,“Fit parameter D”, “Fit parameter E” and “Fit parameter F”;

The “TGO Horizontal Adjustment Method” method requires at least three pairs of
known points to calculate the five parameters which are “Origin North”, “Origin East”, “Slope
North”, “Slope East” and “dH”.

2. The coordinate format in the parameter calculation interface adopts the coordinate
format in the coordinate conversion interface. Please make sure that coordinate format,
ellipsoid type and projection mode are correct before importing files;

3. The already set conversion parameters in the coordinate conversion operation do not take
effect now. After the calculation is completed, click the “Confirm” button to use the
calculated parameters to update the conversion parameters set previously in the coordinate
system settings;

4. When the coordinate format in the imported file is not same as the selected coordinate
format, the coordinate values with incorrect coordinate format are displayed in red on the
file import interface. Please modify the coordinates according to the red prompts, and if not
modified, the default initial value will be adopted;

5. When modifying the imported coordinates in the parameter calculation interface, if the
modified coordinate format is not same as the selected coordinate format, the software will
pop up red prompts. If the coordinate format is not modified as the correct coordinate
format, the calculation operation can not be performed.
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Steps
Open the “CS Manager” tool, by clicking the “Calculate Parameters” button in the upper

part of the interface you can enter the “Calculate Parameters” interface;
Select the type of the parameters participating in the calculation, and you can select

“Ellipsoid Transform Parameters”,“Plane Transform Parameters”,“Elevation Fitting
Parameters” or “Ellipsoid Transform Parameters” + “Elevation Fitting Parameters”;

After these settings are set, import the control point pairs, or manually input the control
point pairs after inserting blank lines. The coordinate format of the control point pairs
here needs to be same as the coordinate format in the coordinate conversion interface;

After inputting all the control point pairs, click the “Calculate” button;
Then the calculated parameter values and residuals will be displayed in the rightest panel;
Click the “Export Report” button, the information in the calculated result panel will be

exported as the file in the txt format; Click the “Export Parameters” button, and the
file in the tp format used to import the coordinate conversion tool will be generated.
Click the “Confirm” button, then the calculated parameters will be directly applied to
the coordinate conversion tool.

9.7 Mask tool
Description
User can create a mask file to filter vehicle body for panoramic pictures.
Steps
Click “Tools – Mask Tool” to open panoramic image mask tool interface.
Click “Load Pano” to import a panoramic picture first. Then use “Ctrl” button with left

mouse to draw on picture to filter vehicle body. Use Ctrl button with right mouse can
cancel last step.

After finish drawing, click “Start Mask” to create a mask picture. User can click “Reset” to
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recreate one.

Finally, click “Save Template” to save this mask file and the file name is “MaskImage.jpg”.

9.8 Ortho Color Tool

Description

This tool can be used to color the point cloud using the orthophoto;
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Requirements for using the tool

1. The input orthophoto and point cloud should be in the same location;

2. Only the projection coordinate is supported for the point cloud;

Steps

Click the “Ortho Color” button, then the tool window pops up;
Input the file path of the orthophoto and the file path of the corresponding projected point

cloud;
Set the output path of the colored point cloud, and set whether to check the “Remove

Unshaded Points” option and the file format, and the default file format is las format;
Click the “Start” button, and wait until the progress bar loads to 100%, which symbols the

completion of the processing.

10 Software Helper
User can check more information about software on “About”.

10.1 Language
User can switch software language here: Chinese, English and Russian.
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10.2 Manual
User can find latest software user manual under this option.

10.3 Update Info
User can check release note about new features and solved bugs.
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10.4 License
User can check software license and machine ID under this option.

10.5 About
User can check current software version and detect latest version to upgrade.

11 Common Shortcut Keys

This chapter describes the shortcut keys commonly used in trajectory view,
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three-dimensional view, and control point view on the CoPre main interface.

11.1 For Trajectory View
Mouse wheel: Zoom in/out POS trajectory.
Mouse right button: Long press to move POS trajectory.
Space button: Full screen trajectory.
Ctrl + Mouse left button: Finish polygon select/distance measurement.
Esc: Undo the last option during polygon select/distance measurement.

11.2 For 3D View
Mouse wheel: Zoom in/out point cloud data.
Mouse left button: Rotate point cloud data.
Mouse right button: Move point cloud data.
Double click left mouse: Centered mouse location.
Space button: Full screen point cloud data.
Ctrl + Mouse left button: Select one point under paired process.
Shift + Mouse left button: Select intersect point based on two lines under paired process.
Ctrl + Mouse right button: Pop on paired point window after select points.

11.3 For Cross Section View
Shift + Mouse left button: Select two points and measure distance.
Mouse wheel: Zoom in/out point cloud data.
Mouse right button: Move point cloud data.
Double click left mouse: Centered mouse location.
Space button: Full screen point cloud data.
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12 Others

This chapter introduces the data processing flow of some special radars.

12.1 Laser data processing of AA1400/AA2400/VZ2000i
Description
Add laser data processing function of AA1400/AA2400/VZ2000i in CoPre 2 need to install
third-party SW.
Step
Prepare RiUNITE-1.0.3 software package, RiUNITE-1.0.3 software License, and RiUNITE 1.0.3

dongle.

Double-click SetupRiUNITE.exe to install with default Settings.

After the SW is successfully installed, open the LicenseCenter from the Start menu bar.
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Click “Import…”，import .lic file.

Click “Save/apply changes now!”.

Notes
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Import License file only once for each PC. You do not need to repeat the operation.
Plug in the RiUNITE-1.0.3 Dongle. Copre will automatically convert rxp files to sdcx files

when processing data during data processing.

12.2 Laser data processing of AU900/AA1300/Alpha3D
Description
Add laser data processing function of AU900/AA1300/Alpha3D in CoPre 2 need to install
third-party SW.
Step
Prepare RiUNITE-1.0.3 software package, RiUNITE-1.0.3 software License, and RiUNITE 1.0.3

dongle.

Double-click SetupRiUNITE.exe to install with default Settings.

After the SW is successfully installed, open the LicenseCenter from the Start menu bar.
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Click “Import…”, import .lic file.

Click “Save/apply changes now!”.
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Notes
Import License file only once for each PC. You do not need to repeat the operation.
Plug in the RiUNITE-1.0.3 Dongle. Check the filter settings and choose MTA to process.

CoPre will automatically convert rxp files to sdcx files when processing data during data
processing.
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13 Common problems and solutions
CoPre 2 cannot display trajectory
Reason: The registration of the track view module fails or is not registered. It usually appears
when CoPre 2 is installed with antivirus software.
Solution:
1. Close the antivirus software and reinstall CoPre 2;
2. Open the installation directory of CoPre 2, find the regMapWinGIS.cmd file in the
mapwingis folder, run it as an administrator, and then run regasm.bat in the installation
directory as an administrator.

The project raw path has changed
Reason: If the data is stored in the mobile hard disk for processing, if the computer is
changed, the drive letter corresponding to the mobile hard disk may change, and the data
path will also change, or the folder name and data path will also change when the computer
is changed. When the task is loaded, the corresponding original data loading failure will be
prompted.
Solution: Re-import the original project.

The task path is changed and cannot be loaded through historical tasks
Reason: The data is stored in the mobile hard disk, and the drive letters displayed on
different computers are different, or the folder name is changed artificially.
Solution:
Method1: Manually select the task file (*.cpr) by opening the task.
Method2: Do not open the software through the shortcut, directly double-click the task file
(*.cpr), and the software will display the double-clicked task.

Add missing data
Reason: The original data is missing when importing the data, so I want to add the missing
data.
Solution: Put the new data into the corresponding directory of the project and refresh the
project.

The project files between multiple tasks are merged into one task
Reason: The data wants to be placed under a task for superimposed display for comparison
Solution: By importing the preprocessing project (*.solve), it can be merged into a certain
task (the original project can also be imported directly). At this time, task 1 will contain the
projects under task 2/task 3/task n. (Note: The merging here is not the merging of file paths
in the true sense, but the file index is changed, so if the path of task 2 / task 3 / task n is
changed after the merging, you still need to re-import Pre-process the project to task.
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The calibration parameters and the equipment do not match
Reason: The calibration parameters in SCAN/Scanner1 or IMG/Camera1 in the project
directory do not match the equipment.
Solution: Contact CHCNAV support team to check.

Process pictures and show error: Ladybug SDK error, operation failed.
Reason: It may be that the original file path of ladybug has Chinese symbols, or the file is
damaged.
Solution: First check whether the pgr path of the original ladybug stream file has a Chinese
path, if not, copy it from the device again.

Process point cloud and show error: Riegl SDK error, unknown sub package V3.6 error.
Reason: The original laser .rxp file is damaged.
Solution: Re-copy the original laser data from the device to rule out whether it was damaged
during the data copying process. If this error is reported after the re-copying, it may be that
the collected data is faulty.

Import .csv format GCP file wrong.
Reason: The format of the control point of the .csv file is wrong.
Solution: Because some of the wrong format of .csv cannot be viewed through excel table,
you can copy the content in .csv to .txt text for viewing, check the format of the control point,
and re-import the control point after confirming that there is no problem.
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14 Parameter settings

This chapter describes the Settings of CoPre parameters and recommended Settings.

14.1 POS accuracy curve

Float/Fixed Ambiguity:
Float:When using carrier phase observations for localization, ambiguity is generated, which
is an integer theoretically. After solving the integer ambiguity by the algorithm, the
localization accuracy is substantially improved with a value is below 3.
Fixed: Sometimes the solution without solving an integer has a value is between 3 and 5. The
precision of the fixed solution is greater than that of the float solution.
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Quality Factor: The quality factor of POS solution is determined according to the fuzziness
fixation and the estimation accuracy, the range is 1-7 and the smaller the better, the value
less than or equal to 2 is better.

DOP：The position accuracy factor, which reflects the satellite distribution, the range is 0.5-99
and the smaller the better, the value less than 3 is better.
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Estimated Position: The information of the accuracy within the filtered solution can reflect
the error size of each position to a certain extent, and the smaller the value the higher the
accuracy.

Estimated Attitude: The information of the internal conforming accuracy of the filtering
solution can reflect the error distribution of each attitude angle to some extent.
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Combined Separation: It represents the position difference value between forward and
reverse solution. The forward and reverse positions are related to many factors and are more
difficult to quantify. The accuracy of the vehicle point cloud is required to be within 10cm,
and if the forward and reverse positions are more than 30cm, it can be considered that there
may be anomalies.

Attitude Separation: Represents the attitude difference value between forward and reverse
solution, related to inertial guidance accuracy, forward and reverse attitude should generally
be in fractions of an arcmin, if greater than 3 arcmin must be abnormal.



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 141

Calculated Satellites: how many satellites involving solving POS.

Tips: The combined separation and attitude separation do not really reflect the error size,
and if the forward and reverse error is large, the probability of the solution result is
anomalous

14.2 POS Optimize
Introduction：
When project is going on, it’s possible that POS on vehicle jumps at parking place. It leads to
points cloud distortion, so users are able to use POS Optimize function to smooth and repair
POS to further solve distortion.
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Parameters Description：
Smooth Distance：Extending distance at the jump to smooth.
Check Threshold：Any POS jump higher than this threshold would be repair, the minimum
value is 0.01m.
Convergence Interval：Determinate 0.01m as default，it represents allowed jump after POS
optimize, which will be less than this Convergence Interval.
Time：POS jump range could be selected by time. The default range is detected by Algorithm.
Check Again：The first check is automatic, users are able to modify all parameters and check
again. The blue area on the main display is jump range.
Repair：Select time range on the column to repair the POS, figure below is before and after
comparison.
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14.3 Filter Settings

14.3.1【MTA Data】

In measurements using the pulsed time-of-flight principle, there exists a theoretical
maximum range of distance measurement which is determined by laser emission frequency
and the light speed. Before the echo signal generated by the previous pulse has returned,
the next pulse signal has been sent. So that the receiver cannot determine echo signal from
which pulse signal has returned, leading to uncertainty in the measurement, which is known
as Multi-Time-Around (MTA) echo.
After receiving the echo pulse, MTA algorithm in CoPre automatically calculates the real
distance to the target based on the echo patterns. The multi-time-around algorithm
determines the maximum number of multi-periods that can be supported according to the
detection capability at different point frequencies.
The following figure shows the point clouds of AU20 laser without multi-time-around
solution (left) and after multi-time-around solution (right)

Tips:
（1）AA1400/AA2400/VZ2000i: Convert rxp to sdcx and must insert RiUNITE 1.0.3 dongle;
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（2）AU900/AA1300/Alpha3D: Check the MTA, then insert the RiUNITE 1.0.3 dongle and
convert rxp to sdcx. If do not check the MTA, also no need insert the RiUNITE 1.0.3 dongle
and conversion.

14.3.2【Circle Noise Filter】

The Circle Noise Filter is not selected as default, users are able to use it when noise still after
MTA Filter. There are 4 options: Close, Low, Medium, High.
Low Option and Medium Option are used on most of noise occasions caused by Aerosols.

There would be slight noise in points cloud on plain ground, these points can be filtered by
High selection.

Figures below are comparison between medium and high filter at edge.
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Tips:
（1）For sparse and edge area, high filter will delete useful points.
（2）This parameters aims to AU20 device.

14.3.3【Mapping Unresolved Targets】

Mapping Unresolved Targets for AA1400 data, mainly for power line data .

Tips:
This parameters aims to Rigel.
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14.3.4【FOV Filtering】

Algorithm Principle:
Filter point clouds outside the FOV range.
As shown in the figure below: the red range is the field of view 90°area, the green range is
the field of view 120°area, if the field angle is set to 90°, the points outside the red range
will be filtered out; if the field angle is set to 120°, the points outside the green range will
be filtered out.
Algorithm Schematic:

Actual Performance:

This setting is only valid for airborne radar data, the default value of AA450 is 60°, AU20 is
360°, and other devices is 120°. The larger the field angle, the larger the point cloud range.
The following figure shows the left set the field angle to 120°, the right set the field angle
to 60°
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14.3.5【3D Distance Filtering】

Algorithm Principle:
Determining the 3D distance minimum and maximum threshold will filter out points that are
not within range of the scanner's 3D distance. The 3D distance filtering origin is the center of
the laser and value is positive downwards;
Algorithm Schematic:

Actual Performance:
3D Distance Filtering is a default Selection, could be modified as individual lidar device type.

14.3.6【Intensity Filtering】

Algorithm Principle:
Filter out point clouds that are not within the setting range according to the grayscale value.
The parameter values can be modified as needed, with different default parameter values for
different laser types;
General point clouds with anomalous reflectivity can be filtered by intensity filtering
Actual Performance:
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14.3.7【Height Distance Filtering】

Algorithm Principle:
Filter out point clouds that are not in the elevation filtering range. The elevation filtering
origin is the laser center, positive upwards;
Algorithm Schematic:

Data Actual Performance

By measuring the noise point above 100m from the point cloud, the range of the maximum
value can be set to [-100, -1] according to the flight height of 100m.
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Tips: Height Distance Filter is mainly determined according to the noise height and the
distance between laser and noise.

14.3.8【Noise Filtering】

Algorithm Principle:
Within the cover radius, if the neighbor points number is less than 5, the algorithom will
fliter this noise. As shown in the figure below: the number of neighbor points within the
radius d of the yellow point is 1; there is no neighbor point within the radius d of the green
point, so these two points will be filtered out, and the red point within the radius d has 5
domain points, the point will not be filtered out.
Algorithm Schematic:

Actual Performance
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If the jumping noise filter distance threshold is set to 1m, it means that the point is within a
sphere with a radius of 1m. If the number of neighboring points is less than 5, the point will
be filtered out. The following figure shows the comparison before and after setting the
jumping noise

Tips:
Generally, flying spots can be filtered by jumping noise. If the point cloud is relatively sparse,
you need to increase the threshold appropriately. It is recommended to determine it larger
than the maximum point intervals, otherwise useful points will be filtered out.

14.4 Colouring Parameters
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Colouring Parameters Description：
RGB Information Range: The default ranges 0~65535，or 0~255. color range determines
information storing space and abundance.
Remove unshaded points: Delete points which are not colored.

Filter Tower Shade : Default selection, it solve the problem that the tower color is assigned
to the ground when the power line data is colored (the option of the vehicle data is disabled),
the comparison diagram is as follows:

Trigger Filter Interval: This setting is only valid for MMS vehicle data, and the default value is
10m. When the on-board point cloud coloring is blocked by the front or rear of the car, this
parameter can be appropriately increased.
Cover Radius: This data is only valid for vehicle-mounted data. The default determination is
8.5m. When the MMS point cloud coloring is blocked by the front or rear of the vehicle, this
parameter can be appropriately increased.
Mask:Mask Tool works on MMS vehicle data, users are able to use it to make mask based on
a panoramic picture. Press Shift+Left Click to draw a mask.
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Drawing Illustration

Camera Selection It’s possible to select individual camera to colorize the point clouds.
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14.5 Refine

Refine function allows selecting pioneer point next to GCP to refine point clouds to improve
absolute accuracy.

14.5.1【Mode 1: Refine POS(position only)】

Algorithm Principle:
This function refine position information in PosT file, mainly applied on MMS vehicle data.
Algorithm Schematic

Actual Performance

Correction Mode 1 Parameter Description
The distance threshold is set to 500m by default, and the smoothing threshold is set to 50m
by default. That is, when the distance between GCP is less than 500m, the position error
value of POS is calculated according to the error of adjacent GCP. When the distance
between GCP is bigger than 500m, it smooths the area in a 50m radius neighbor range of
GCP.
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14.5.2【Mode 2: Refine POS(position and attitude)】

Algorithm Principle:
This function refines position and attitude information in PosT file. It embeds GCP
coordinates to solve POS along with attitude from INS, and position from GNSS. It applies on
strip MMS vehicle data.
Algorithm Schematic
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14.5.3【Mode 3：Refine Points Cloud (Based On near control point

error)】

Algorithm Principle:
Sampling neighbor GCP errors to correct points. It applies to polygon plain area or urban
area with enough GCP. Need to determine smooth distance. The outward expansion distance
of the GCP convex hull boundary line, from the GCP convex hull boundary line to the
outward expansion boundary line gradually tends to 0. The default value is 50 meters, that is,
the boundary line of the GCP is expanded by 50m, and the boundary line from the boundary
line of the GCP to the 50-meter boundary line that is expanded gradually tends to 0. If the
error of the GCP is large, the value can be appropriately adjusted to make the correction
amount of the expanded point cloud transition smoothly.
Algorithm Schematic:

Actual Performance:
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14.5.4【Mode 4：Refine Points Cloud（Point Cloud Overall Offset）】

Algorithm Principle:
The overall rotation offset of the point cloud is applicable to the scene where there is a
relative position offset between the GCP and the point cloud. When using this algorithm, try
to ensure that the GCP cover the survey area and are evenly distributed.
Algorithm Schematic:

Actual Performance:
Before correction, the GCP is 100cm away from the point cloud. After Mode 4, the GCP is on
the point cloud. The figure below is the comparison before and after Mode 4.
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14.6 Adjust

When the point clouds between different airways are layered, the error between point
clouds can be eliminated through adjustment. According to the data type, the adjustment
can be divided into airborne adjustment and vehicle-mounted adjustment.

14.6.1【Adjust airborne data】

Parameters Description:
Block Size：
The airborne adjustment divides the point cloud into blocks according to the block size, the
unit is m, and the default value is 100, that is, the point cloud is divided into 100*100 point
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clouds according to the plane position. The larger the value, the fewer block point clouds,
the faster the adjustment efficiency, and the worse the adjustment effect; the smaller the
value, the more block point clouds, the slower the adjustment efficiency, and the better the
adjustment effect. Maximum setting is 150m.
Grid Size: It is a resampling size, this parameter is used for point cloud thinning, the unit is m,
the default value is 0.3, that is, all points in every 0.3m cube are thinned to 1. The larger the
value, the more the number of thinned point clouds, the faster the adjustment efficiency,
and the worse the adjustment effect; Low. Maximum setting is 1m.
Adjustment mode: there are 3 modes: change position, change attitude, change position
and attitude. Attitude adjustment only is selected by default in the airborne adjustment
parameter interface. When the error between flight strips is small, you can select only
attitude adjustment mode, which has high efficiency and the effect can meet the
requirements; when the error between flight strips is large, It is recommended to select the
adjustment position and attitude, and the adjustment effect is good. It is not recommended
to select only the adjustment position mode for airborne adjustment.

14.6.2【Adjust vehicle-mounted data】

Parameters Description:
Block Time Interval: MMS divides the point cloud into blocks according to the set interval,
the unit is s, and the default value is 5s, that is, the original point cloud will be divided into
pieces of point cloud data according to 5s. The larger the value, the fewer block point clouds,
the faster the adjustment efficiency, and the worse the adjustment effect; the smaller the
value, the more block point clouds, the slower the adjustment efficiency, and the better the
adjustment effect.
Adjustment mode：It includes 3 selection: change position, change attitude, change position
and attitude three modes. The vehicle-mounted adjustment parameter interface defaults to
the adjustment position and attitude. The adjustment effect is good, but the efficiency is
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slow. The vehicle-mounted adjustment can also be selected to only adjust the position. The
efficiency is high, but the effect is worse than the adjusted position and attitude. It is not
recommended to use the vehicle Adjustment Select the adjustment attitude mode only.
Smooth Time： The unit is s. According to the smoothing time, the point cloud at the
beginning and end of the time period is selected for smooth transition, so as to ensure that
there are no faults in the point cloud of the adjustment part and the edge part of the point
cloud that has not been adjusted.
Selection Range: When checked, only adjust the point cloud within the time range of the
selected trajectory. It can be applied on batch projects.

14.7 Reconstruction

14.7.1【AT】

Parameters Description:
Scene: Select the scene according to the data type. The scene is divided into three types:
town, mountain and plain. The number of connection points extracted by the software is
different when the scene type is different.
POS Accuracy：Set the accuracy of plane and elevation when solving, the default is 0.05.



CHCNAV COPRE 2 USER MANUAL | 2023-12 P a g e | 160

14.7.2【DOM】

Parameters Description：
Data Source：Select according to the corresponding data, where the laser data source is only
optional in the high-efficiency mode, and the image data source is mandatory;
Mode Setting： Contains two modes of high efficiency and high quality. High efficiency
generates orthographic speed quickly, but the effect is poor. High quality generates
orthographic speed slowly, but the effect is better.
Scene: Contains 3 scenes of town, mountain and plain, select according to the actual data
scene type.
POS Accuracy：The allowed range of accuracy.
DOM Setting： Select Adaptive Resolution, the software will automatically calculate the
resolution of the orthophoto, if you select Custom Resolution, the software will output the
orthophoto according to the set resolution；

If there are three setting methods for orthorectification in the results, adjustment, and
correction nodes, corresponding to the three modes, as follows:

Mode 1: Select the point cloud and image as the data source, and the default is only
the high-efficiency mode, which is orthographic fast spelling;

Mode 2: Select the image as the data source, and select the high-efficiency mode. This
mode quickly generates orthophotos, but the quality of the results is average; it is suitable
for non-urban areas

Mode 3: Select the image as the data source, and select the high-quality mode. This
mode will first short and then do orthorectification internally, so the output effect is good
and the quality is high, but it takes a long time.
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Mode 1 2 3

Data Source
Points Cloud &

Images
Images Images

Solving Mode Efficiency Quality Quality

Time Medium Short Long

Scenarios All Non-Urban All

Shortage
Need point cloud

data.
Quality of texture is

not good

Quality of Water
and vegetation is

not good

Tips:
Generate DOM based on AT is mode 3 above.

14.7.3【3D Modeling】

Parameters Description：
Data Source: Select data according to project, laser is optional.
Mode Setting: Mode Setting includes high-efficiency and high-quality modes, the
high-efficiency generation model is fast, but the effect is poor, and the high-quality
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generation model is slow and the effect is better.
Process Mode：Supports cluster 2 modes.

Single Mode：Modeling on 1 PC；
Single Mode：Modeling on multiple PCs within a local area network.

Block： There are two ways: Adaptive and Custom. When self-adaptive is checked, the
software will automatically calculate the appropriate tile size according to the remaining
memory of the computer. When custom is checked, set the tile size and click the
confirmation button on the right, and the software will The required memory consumption
will be calculated according to the size currently set, and the estimated memory usage
should be less than 60% of the computer memory.
Output DOM：It will output DOM simultaneously with model.
Tips：

There are 2 modeling methods at AT node like below:

Method Method 1 Method 2

Data Source
Points Could &

Images
Images

Mode Efficient Quality

Time Cost less more

Scene All Scene

Shortage Distortion on water and vegetation

Advantage Efficient
Higher

Completeness
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CHC Navigation
Building CHCNAV | Smart Navigation & Geo-Spatial Technology Park
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